To insure proper operation and full value from your printer, please read this instruction manual and the warranty carefully. This Operation Manual must be read and understood by all operators, supervisors, and maintenance personnel. It must be stored with the unit for reference at any time. All new operators and personnel should be trained and be made familiar with its safe use.
This Operation Manual must be read and clearly understood by all operators, supervisors, and maintenance personnel. It must be stored with the unit for reference at any time. All new operators and personnel should be trained and be made familiar with its safe use.

Contents

1.0 – INTRODUCTION ........................................................................................................ 5
   1.1 – Description ................................................................................................................ 5
      1.1.1 – Overview ......................................................................................................... 6
   1.2 – Safety ...................................................................................................................... 7
      1.2.1 – Print head damage ............................................................................................ 7
      1.2.2 – Moving the printer to a different location ......................................................... 7
      1.2.3 – Putting the wrong type of ink or used ink into the reservoir ............................... 7
      1.2.4 – Clean or wipe the head only with the specially designed cloth ....................... 8
      1.2.5 – Inadequate power surge protection ................................................................ 8
   1.3 – Safety Summary ....................................................................................................... 8
      1.3.1 – BEFORE APPLYING POWER ........................................................................ 8
      1.3.2 – PROTECTIVE GROUNDING ....................................................................... 8
      1.3.3 – DO NOT REMOVE THE COVER OF THE PRINTER .................................... 8
   1.4 – Emergency Stop ....................................................................................................... 9
   1.5 – Machine Specifications ............................................................................................ 9
      1.5.1 – General ............................................................................................................ 9
      1.5.2 – Power Requirements ..................................................................................... 9

2.0 – INSTALLATION ........................................................................................................ 10
   2.1 – Initial Inspection ...................................................................................................... 10
   2.2 – Leveling the Printer ............................................................................................... 10
   2.3 – Connections at the Back of the APS (air/power supply) ....................................... 11
   2.4 – Installing the Compressed Air ............................................................................... 11
   2.5 – Connecting to Main Power .................................................................................. 13
2.6 – Adjusting the Ink Feed and Purge Pressures ................................................................. 13
2.7 – Adjusting the High Vacuum .......................................................................................... 14
2.8 – Adjusting the Low (meniscus) Vacuum ...................................................................... 16
2.9 – Setting the Print Head Distance ................................................................................. 19

3.0 – MACHINE OPERATION ............................................................................................... 20
3.1 – Description ..................................................................................................................... 20
3.2 – Initialization .................................................................................................................. 21
3.3 – Setting/Selecting a Template .......................................................................................... 22
3.4 – Populating the Files Queue ............................................................................................. 23
3.5 – Printing Image Files ....................................................................................................... 24
3.6 – Purging the Print Head .................................................................................................... 25
3.7 – Machine Tools and Settings Menus .............................................................................. 25
3.8 – Machine Standby or Shutdown ...................................................................................... 25

4.0 – TOOLS ......................................................................................................................... 26
4.1 – Introduction .................................................................................................................... 26
4.2 – Hot Folder ....................................................................................................................... 26
4.3 – Print Counter .................................................................................................................. 26
4.4 – Engineer Tools ............................................................................................................... 26
4.4.1 – Graph ......................................................................................................................... 27
4.4.2 – Status Log ................................................................................................................... 27
4.4.3 – Message Log .............................................................................................................. 28
4.4.4 – Repeats (number of printing) ................................................................................... 28
4.5 – Engineer Settings ......................................................................................................... 29
4.5.1 – Physical Settings ...................................................................................................... 29
4.5.2 – Temperatures .......................................................................................................... 29
4.5.3 – Jet Usage ............................................................................................................... 30
4.5.4 – Ink System ........................................................................................................... 30
4.5.5 – Fire Pulse ............................................................................................................. 31
4.5.6 – Servos and velocities ......................................................................................... 32
4.5.7 – Calibration .......................................................................................................... 32

5.0 – LOAD, SAVE, AND BACK UP SETTINGS .......................................................... 33

5.1 – Introduction ........................................................................................................... 33
5.2 – Load and Save Settings ......................................................................................... 33
5.3 – Back-up Settings ................................................................................................... 33

6.0 – MACHINE TROUBLESHOOTING ................................................................... 34

6.1 – Introduction .......................................................................................................... 34
6.2 – General Troubleshooting Guidelines ...................................................................... 35
6.3 – Symptoms and resolutions .................................................................................... 36
    6.3.1 – Image quality ................................................................................................. 36
    6.3.1.1 – Missing horizontal lines ............................................................................. 36
    6.3.1.2 – The top portion of each head section is not printed well ......................... 37
    6.3.1.3 – The top portion of each head section loses printed lines gradually section by section .................................................................................................................. 37
    6.3.1.4 – Visible gap or overlapping at the junction between two consecutive head sections .................................................................................................................. 37
    6.3.1.5 – Visible vertical misalignment between two consecutive head sections .... 38
    6.3.2 – Ink feed and air system related symptoms/resolutions .................................. 42
    6.3.3 – Motion-related symptoms ............................................................................. 44
    6.3.4 – Image file and template setting related symptoms ......................................... 44
    6.3.5 – Other symptoms ............................................................................................ 44
1.0 – Introduction

1.1 – Description

The Exile Technologies brand SPYDERII is a direct to screen imaging device. It directly images emulsion-coated screens from computer generated digital design files. It uses solid phase-change water developable ink and a 256-nozzle piezoelectric print head. This combination of technologies enables imaging of highest halftone frequencies and produces a screen quality that equals, and in many cases surpasses, the quality of film stencils. In addition, the direct to screen imaging method results in the elimination of film costs and archiving, fewer screen-processing steps, and minimal screen handling.

Artwork files with the Adobe Systems, Inc. PostScript Level 2 format are interpreted with Raster Image Processor (RIP) software and color separated to different files with one-bit TIFF 6.0 formats. The software (Spyder Control Panel) running this machine is capable of reading and imaging 600 DPI and 1200 dpi one-bit TIFF files either uncompressed, or files compressed with the pack-bits compression or LZW method. The only other requirement is to include the computer running this machine in the same Local Area Network (LAN) as the RIP server, so that all the output TIFF files to be imaged can be accessed. Typically, these are the steps involved when imaging a particular artwork:

- Art department generates artwork in EPS, postscript, or PDF format
- Files are transferred to server running RIP software
- RIP software color separates and converts files to 1-bit TIFF format
- Operator selects the converted files to directly image onto the emulsion-coated screens
- Screens are developed and water jet to remove the ink wax deposited in the imaging process
- Screens are ready for use
1.1.1 – Overview
1.2 – Safety

READ ME FIRST

With proper use, the SPYDERII printer will provide years of reliable service. However, failure to follow the correct operator procedures can cause severe damage to the printing mechanism. What follows is a short list of things NOT to do. Any damage resulting from failure to follow proper procedures will NOT be covered under the warranty provisions for the SPYDERII printer. Therefore, please read this list carefully and if you have any questions, please contact Exile Technologies for clarification before attempting to operate the printer. These points are covered in greater detail in the text but they are collected here to emphasize their importance before any opportunity arises to cause damage due to a lack of knowledge of proper procedure.

1.2.1 – Print head damage

Print head damage can be caused if the print head comes into physical contact with the print-media surface or the screen emulsion surface. The print head should never touch the screen frame or screen emulsion or any print media fastened to print surface. Some ways to prevent this are:

- Never put media of different thickness on the screen surface at the same time.
- Never allow the edges or corners of the print media to be loose from the screen surface (use masking tape to hold edges and corners down if they are not completely flat against the surface).
- ALWAYS use the Thickness Dial when changing mesh/emulsions.

1.2.2 – Moving the printer to a different location

QUALIFIED Technical support personnel should be called to move the printer. Always disconnect the printer from wall power for at least 15 minutes while maintaining the lung vacuum before attempting to move it.

1.2.3 – Putting the wrong type of ink or used ink into the reservoir

Putting the wrong type of ink or used ink into the reservoir will result in print head damage and void the print head warranty.
1.2.4 – Clean or wipe the head only with the specially designed cloth

The Head Cleaning cloth is specially designed to absorb the ink without clogging the jets and must be used. **NEVER SUBSTITUTE ANY OTHER MATERIAL FOR THIS PURPOSE.**

1.2.5 – Inadequate power surge protection

Inadequate Power Surge Protection between the wall power and the printer can result in serious damage to the printer electronics. Therefore, a surge suppresser or Uninterruptible Power Supply (UPS) between wall power and the printer is recommended in order to protect against power outages and surges. A power line conditioner may be required.

### 1.3 – Safety Summary

The following general safety precautions must be observed during all phases of operation, service, and repair of this printer. Failure to comply with these precautions or the specific **WARNINGS** given elsewhere in this manual will violate the safety standards for design, manufacture, and the intended use of this printer.

Exile Technologies assumes no liability for the customer’s failure to comply with these requirements.

1.3.1 – BEFORE APPLYING POWER

Verify that the product is set to match with the line voltage.

1.3.2 – PROTECTIVE GROUNDING

Make sure to connect the protective grounding to prevent an electric shock before turning on the power. Never cut off the internal or external protective grounding wire, or disconnect the wiring of protective grounding terminal. Doing so will cause a potential shock hazard that may bring injury to a person.

1.3.3 – DO NOT REMOVE THE COVER OF THE PRINTER

Operating personnel must not remove the cover of the printer. Component replacement and internal adjustment can only be done by qualified service personnel.
1.4 – Emergency Stop

An emergency stop “panic button” is located in the right-hand side of the machine. It is a large, red button that can be pushed to remove all power from the machine. This is the safest way to insure that dangerous voltages are not present in the machine, but when this device is deactivated, the ink will solidify, and an unusually long time will be required to return the machine to service. To recover from an emergency stop, turn the button clock-wise and press the “Start” button below it.

1.5 – Machine Specifications

1.5.1 – General

- Technology: Phase-change piezoelectric ink jet
- Halftone capability: 75 lpi @ 600 dpi; 110 lpi @ 1200 dpi
- Resolution: 600 dpi, 900 dpi, 1000 dpi, 1200 dpi
- Print medium: Water-soluble, UV-opaque wax
- Connection to prepress: LAN Ethernet
- Data format: 1-bit TIFF 6.0
- Compatible screen systems: All types of coating
- Max frame size: DTS 30 30”w x 40”h     DTS 52 56”w x 50”h
  DTS 30 25”w x 30”h     DTS 52 52”w x 40”h
  DTS 30 51”w x 78”h x 36”d  DTS 52 77”w x 90”h x 36”d
- Machine size: DTS 30 300 lbs.     DTS 52 340 lbs.

1.5.2 – Power Requirements

- Voltage standard: 120V/220V, 50–60 Hz
- Voltage fluctuations: Not to exceed ± 5% of 115V (103.5 V to 126.5 V)
- Voltage sag: Should not fall below 103.5 for more than .1 seconds
- Voltage impulses: Not to exceed 1.5ms in duration with a rise/fall time between 500ns and 500ms. If your power does not meet these specifications a line conditioner must be installed.
- Ground to neutral voltage: Should measure less than 2 Volts
- Ground wire resistance: Should measure 0.25 ohm or less
- Minimum power at idle: 250 W
- Maximum power: 500 W
2.0 – Installation

2.1 – Initial Inspection

The printer was carefully inspected, tested, and packaged before being shipped. Carefully inspect the printer for any physical damage that may have been sustained in transit.

Notify your printer supplier and file a claim with the carrier immediately if you believe the printer has arrived in a damaged condition.

2.2 – Leveling the Printer

For quality operation it is important that the printer be carefully leveled. This is accomplished using a bubble level and a wrench to adjust the leveling pads.

1. Position the carriage about midway vertically. Place the bubble level on the upper horizontal surface of the carriage.
2. Raise or lower the leveling pads on the right end of the printer to center the bubble. Adjust both the front and rear leveling pads equally.
3. Place the bubble level vertical and against the printer screen emulsion. Raise or lower the right-front leveling pad to center the bubble.
4. Repeat steps 1 through 3 until the printer is level, both side-to-side and fore and aft.
2.3 – Connections at the Back of the APS (air/power supply)

The following connections at the back of the APS are factory-preset before shipping.

2.4 – Installing the Compressed Air

The printer needs a small amount of compressed air for operation. An air regulator and air filter are located on one of the structural beams in the rear of the printer. The amount of air is less than 0.1 CFM and no more than 30 psi; therefore, a supply tube of ¼ inch (6mm) diameter or greater is satisfactory. The input connection is ¼ inch Female National Pipe thread.
1. Insert one end of the pressurized air hose into the connector of the on-wall compressed air tube.

2. Insert the other end of the air hose into the valve next to the pressure gauge at the back of the printer.

3. To feed air to the printer, open the valve on the wall pipe. Then pull upwards on the knob of the pressure gauge, and turn it clockwise until it reaches 45 psi. When set, press the knob down to lock it.
2.5 – Connecting to Main Power

Be certain that the Main Power switch is in the OFF position prior to connecting the printer to an AC power source. Make sure the power in your facility meets minimum requirements. A power line conditioner may be required. It is important that once installed, the printer not be unplugged. The printer should be connected to a 15-amp AC power source. It is recommended that an un-interruptible power line conditioner be installed in large commercial buildings. A UPS with at least 800VA will provide standby power for 1 hour of operation or 4 hours of head heat during idle.

Plug in the power cord at the back of the printer on the APS (air/power supply) box. Plug the other end into a 115V or 220V power outlet, depending on the model of the printer:

- The model with a D/C vacuum pump may be plugged into either 115V or 220V outlet;
- But the model with an A/C vacuum pump can only be plugged into a 115V outlet.

Then press the switch above the power inlet, and a green light will be on.

2.6 – Adjusting the Ink Feed and Purge Pressures

Verify that the ink feed pressure gauge be ~7 psi. If not, it can be regulated by lifting the knob below the gauge and turning it right to increase or left to decrease the pressure. When finished, push the knob back down.
Verify that purge pressure gauge be ~4 psi. If not, it can be regulated by lifting the knob below the gauge and turning it right to increase or left to decrease the pressure. When finished, push the knob back down.

### 2.7 – Adjusting the High Vacuum

The high vacuum (also called lung vacuum) is internally regulated by the air system. It is pre-set in factory before shipping and seldom needs readjustment. The gauge should read below –22 inches of mercury. If not, perform the following steps:

- Remove the right side panel from the air/power supply (APS) box.
- Adjust the High Vacuum to –22” Hg by turning the white knob inside the APS box near its top center.
While watching the High Vacuum gauge, turn the knob counterclockwise to decrease or clockwise to increase the value.

- For each adjusting turn, disconnect the green tube labeled VAC-G located at the bottom back of the APS box by depressing the orange safety lock and pulling the tube out. Then reconnect it to reset the gauge.

- Repeat the above steps (turning the knob and disconnecting/reconnecting VAC-G) until -22" Hg is reached.

The vacuum pump should not cycle on for more than a few seconds, and it should stay off for several minutes. A continuously running pump would be an indication of an air leak around the machine. This will also be manifested by a change in the vacuum pressures shown by either vacuum gauge.
2.8 – Adjusting the Low (meniscus) Vacuum

The low vacuum is also internally regulated by the air system. It is pre-set in factory before shipping and seldom needs readjustment.

The low vacuum gauge should read between 2.5 and 3 inches of water. Its purpose is to keep the ink from weeping at the bottom nozzles’ outlets, i.e., if the vacuum is set too low (<2.0” H²O), it won’t be able to hold the ink at nozzles’ outlets and will result in ink’s draining (weeping, due to gravity) at the bottom nozzles’ outlets. On the other hand, if the vacuum is set too high (>3.0” H²O), the surface tension at the outlets of the top nozzles will break and it results in air trapping inside the top outlets. This is called “ink ingestion” phenomenon which will block the jetting of the top nozzles, hence no visible printing can be achieved.

When either ink weeping or air ingestion happens, please call Exile Tech’s support for service help. The detailed procedure is listed below for reference in case the users plan to have their hands on it.

- Locate the area for adjusting the low vacuum system
There is a tiny screw directly beneath and to the left of the clear tubing in the area. Use a 1/16” screwdriver to turn the screw clockwise to adjust the vacuum setting lower, or counterclockwise to adjust it higher.

When making an adjustment, disconnect the red tube labeled PURGE–R (by depressing the orange safety lock and pulling the tube out) from the back of the APS box. Then reconnect it to reset the system to the new setting.
If necessary, adjust the flow control valve. Turn it counterclockwise to open the vacuum path (hence increasing the vacuum recovery rate), or clockwise to restrict the vacuum path (hence reducing the vacuum recovery rate).

Watch the Low Vacuum gauge’s needle move when disconnecting and reconnecting the PURGE-R tube as the needle’s moving speed is an indicator of how fast the vacuum system can recover. With the flow control valve fully open, it has the max recovery rate which is not necessarily the best choice since over-vacuuming may occur. Practically, the desirable recovery rate is when the needle’s moving speed is about 50% of the max recovery rate. Repeat the above steps until the desirable recovery rate is achieved.
2.9 – Setting the Print Head Distance

Before running the machine for the first time make sure the print head is set as far as possible from the frame and screen.

The head distance can be precisely set once the machine has been initialized and the appropriate screen has been installed. The dial at the front of the APS (air/power supply) box can be used to retract the distance by turning it to a lower number, or to extend it by turning it to a higher number.
3.0 – Machine Operation

3.1 – Description

Artwork files are created in graphic workstations and transferred via a Local Area Network connection to a server running RIP (Raster Image Processor) software. Artwork files can have any format the RIP software would handle, typically some variation of Adobe Postscript. The RIP software would be set up to output color separation monochrome one-bit TIFF files. The software (Spyder Control Panel) running this machine can handle 600 dpi or 1200 dpi one-bit TIFF 6.0 files uncompressed, or compressed with pack-bits or LZW compression. The color separated TIFF files that the RIP software outputs must be placed in a network location accessible by the machine software via the Local Area Network.

Once the files output from the RIP software are ready, they can be transferred to the “Spyder Control Panel” software running the machine from which they can be directly imaged to the screen:
3.2 – Initialization

Rotating the emergency button clockwise and then pressing the “Start” button just below it will power up the machine. Then click on the “Spyder Control Panel” shortcut icon on the desktop to start the software. After the app is started, click the Continue button. The head assembly and drum support will move to the home position.

After reaching at the home position (at bottom-right corner of the machine), both the ink tank and print head will be warmed up, towards the preset target temperatures.
3.3 – Setting/Selecting a Template

The template selector must be used every time a screen with different dimensions is installed. To set or select a template, go to the top menu Tools > Template... An example pop-up page is shown here:

![Template Settings](image)

The definition of those parameters is illustrated in the following diagram:

![Diagram](image)

The template is the printable area within a fixed-size screen, and its bottom is at “Screen offset” from the screen’s bottom. Hence the selection of template’s size depends on the size of the screen to be used. The
printed image’s desired position can be set in X- or Y-axis independently. For X-axis, it may be Auto-Center or an Offset (relative to the left side of the template). For Y-axis, it may be Auto-Center, Top offset, or Bottom offset. (Earlier versions of software have only Auto-Center and Top offset in Y-axis.)

Note that Template’s height = Top offset + Image’s height + Bottom offset. Typically for a selected template, the size of the image files to be printed is fixed, therefore selections of Top offset and Bottom offset are mutually exclusive since once either offset is set, the other is fixed internally.

Be careful that a correct template be selected when switching to a different drum/screen during operation. If a bigger template is incidentally (and wrongly) used for a smaller screen, without a hardware-sensing capability for different screen sizes the software may move the head assembly beyond the screen area and bump onto the screen’s top clamp, hence damaging the head.

3.4 – Populating the Files Queue

There are two approaches to add an image file into the Active Queue waiting for to be printed. The formal one is to go to the top menu File > Load Image…. The other is to use the “drag and drop” approach that a single or a selected group of image files in a file folder (usually in open windows on the desktop) can be dragged/dropped into the Active Queue.
In the Active Queue the top-positioned job is printed when the **Print** button is pressed. The drag-and-drop approach (by clicking on a specific job) can be used to promote any job by moving it to the top of the Active Queue.

Note that when an image file is populated into the Active Queue, the default Template is attached and the populated is actually a job containing the image file and its associated template. To verify/preview, double click the job and an Image Details Window is displayed as below.

![Image Details Window](image.png)

In some cases, different template or dpi settings may be used to alter the job, if necessary.

### 3.5 – Printing Image Files

In the Active Queue the top-positioned job is printed when the **Print** button is pressed. After the printing has started, **Pause** or **Cancel** button can be used to pause or stop it in case a visual inspection on the printed image is needed. Usually **Pause** is preferred since a follow-up **Resume** or **Cancel** can be used. **Cancel** during printing (i.e., not after a Pause) is seldom used since it would place a quick stop action, hence is reserved for a more critical scenario such as mechanical hindrance.

After a successful printing, the job is moved to the Held Queue so that, if necessary, it can be moved back (by drag-n-drop) to the Active Queue.

Any jobs in the Active or Held Queue can be deleted by right-clicking the job and then select **Delete**. Note that when a job is deleted, the original image file still exists in the folder where it has been residing. This is because the deleted in either queue is a job (a meta-file connecting the image file and the associated template), not the original image file.

Occasionally, in order to recover disk space the image files need to be deleted to clean up the folder. In such case, the standard Windows operation of file deletion may be used.
It is recommended to perform a purge procedure before imaging files after a long period of idling or after warm-up.

3.6 – Purging the Print Head

The Purge button is used to force ink out of the nozzles, hence unclogging potentially ink-dried openings. It works only during non-printing condition when the print head assembly is at the home position. Make sure the ink container is placed right below the print head, and have the cleaning cloth ready. Repeat the procedure if necessary. Gently clean the excess ink with the cloth at the bottom of the head, making sure the wiping motion be sideways, never vertical.

After the purge procedure, wait one or two minutes for the pressures to settle and any warning messages to go away.

3.7 – Machine Tools and Settings Menus

During normal operation these menus are hidden and only accessible by clicking the top menu Tools > Engineering Mode and then entering the password. They are usually only needed for machine setup or troubleshooting – please refer to Chapters 4 and 5.

3.8 – Machine Standby or Shutdown

At the end of the day the machine can be put in standby mode, or shut down completely. Standby mode can be activated by clicking the top menu Heaters > Standby so that the machine will be placed in a mode of reduced heating to maintain both head and ink supply at the idle temperature settings. This mode does require air/vacuum system be turned on so that a vacuum can be applied to prevent the ink in the head from weeping.

The machine can be switched back to Active (production) mode manually by clicking the top menu Heaters > Active, or automatically by clicking the top menu Heaters > Autostart Active at the time set in Heaters > Autostart Time.

To shut down the machine, click File > Exit or just close the program window. After the program exits, press the emergency button at the right-hand side of the machine, and the computer can also be shut down if necessary.
4.0 – Tools

4.1 – Introduction

Under the top menu Tools there are a variety of tools that do machine- or operation-related setup, or provide useful information. The one used most often is Templates which has been described in section 3.3. Those related to machine’s internals and to detailed operation information are placed in the submenu Engineer Mode which requires a password to get access to.

4.2 – Hot Folder

The Hot Folder is used to provide storage to receive the rasterized TIFF files sent by the RIP (installed and running at a remote PC). The Spyder Control Panel software periodically checks any new-coming TIFF files and places them in the Active Queue. The approach of Hot Folder should be used with precaution, however, because the active queue may be swamped easily. Besides, the user is responsible for removing the image files in the folder if so desired. Hence although the hot folder is provided as an option, populating the Active Queue manually as described in section 3.4 is recommended.

4.3 – Print Counter

The Print Counter provides information about the total number of completed jobs (images printed). In addition, the total numbers of black pixels printed as well as ink feeds performed are also logged, which may be used for troubleshooting or operation optimization.

4.4 – Engineer Tools

They are available after going to Engineer Mode and entering Password (“spyder”).
4.4.1 – Graph

The Graph Utility displays real-time variables (mostly temperatures), and on/off control signals applied to the heaters or the air/vacuum system, at user’s discretion. One useful application is to determine the appropriate LOIS threshold setting as described in section 6.3.2.

4.4.2 – Status Log

The Status Log displays all the variables and on/off control signals with the latest status updated.
4.4.3 – Message Log

The Message Log records all the changes of machine state after the application has started. The log can be saved in a file retrieved later for trouble-shooting.

4.4.4 – Repeats (number of printing)
4.5 – Engineer Settings

Engineer settings are available after going to Engineer Mode and entering Password (“spyder”).

4.5.1 – Physical Settings

This is used to select the SpyderII model in use if the application installed has multi-model option. In most cases, the software installed has already been configured to match the machine shipped.

4.5.2 – Temperatures

The Temperature Settings dialog box is shown below.

![Temperature Settings Dialog Box]

Note that if the temperature of printhead or ink supply is above the “Max to print” setting, wait until it cools down to within the target range, and also that the Idle Target temperatures of printhead and ink supply are for Standby mode.
4.5.3 – Jet Usage

There are 256 nozzles on a printhead. In case a small number of nozzles are non-functional (i.e., damaged or clogged so badly they cannot be cleaned by purging), the dialog allows deselecting those non-functional nozzles.

![Jet Usage Settings](image)

4.5.4 – Ink System

A typical factory-preset setting is shown here for reference.

![Ink Level Settings](image)

The principle of ink level sensing is that a thermistor gives a lower temperature reading when submerging in the ink than exposing above the ink surface. There are four thermistors at different levels (Top, Mid-top, Mid-bottom, and Bottom) in the ink supply tank. By setting appropriate...
threshold temperature for the thermistors the software can detect the ink level inside the tank. Usually the difference between the above-ink and below-ink temperatures may be up to 40 °C, hence the threshold setting is less critical — typically a mid-value between these two temperatures would work fine.

The threshold setting of the printhead thermistor (called LOIS – Low On Ink Sensor) is more critical because an inappropriate setting may result in two possible bad scenarios:

1) If the LOIS threshold setting is too low, the software will think the LOIS reading is higher than the ink level in the on-head reservoir, hence continuing the ink feed action for max “Ink feed trials.” It may eventually cause over-feeding and the backflow of ink through the vacuum tube.

2) If the LOIS threshold setting is too high, the software will think the LOIS reading is lower than the ink level in the on-head reservoir, hence no ink feed action will be performed. It’ll eventually cause ink-starvation (i.e., not enough ink to jet out), hence a portion (usually the top part) of image won’t be printed.

The LOIS setting is detailed in section 6.3.2.

4.5.5 – Fire Pulse

A typical factory-preset setting is shown here for reference.

The settings are tuned for each resolution (600dpi, 900dpi, etc.) and rarely need readjustment, except the BiDirectional Offset. Please call tech support if there’s any question.
4.5.6 – Servos and velocities

A typical factory-preset setting is shown here for reference.

![Servo and Velocity Settings](image)

The servo settings are fixed, hence not adjustable. The velocity settings are resolution-specific and may be adjusted for each resolution of imaging.

4.5.7 – Calibration

A typical factory-preset setting is shown here for reference.

![Machine Calibration](image)

The X-DPI adjustment is seldom required, hence set to 0%. Y-Spacing allows small adjustments to the vertical positions of the image printed on each section movement of the printhead.
5.0 – Load, Save, and Back up Settings

5.1 – Introduction

When the Spyder Control Panel program starts, it needs two parameter files to initialize the machine’s state to the one as the last successful exit. One is machine related as set in Physical Settings (section 4.5.1); the other is operation related, a so-called Configuration Settings, and is a collection of those parameters set in Tools (Chapter 4) as well as the template settings (section 3.3). If either file does not exist, a default set of parameters are used.

When the machine is shipped out of factory, both parameter files have already been set and saved in a hidden folder. The machine-related file cannot be modified. The configuration file (in XML format) is updated during operation whenever there is a change in any parameters; hence at the exit of the program, the last good configuration is always saved and can be used for next startup.

The user does have the ability to save, load, or back-up the configuration setting in a user-specified folder.

5.2 – Load and Save Settings

The configuration file should be in XML format, and the specified folder should be accessible to standard users without administrator privilege.

5.3 – Back-up Settings

Back-ups can be enabled so that the configuration settings can be saved to a user-specified file/folder during operation whenever there is a change on any parameters.
6.0 – Machine Troubleshooting

6.1 – Introduction

The machine is composed of several subsystems: mechanical, electrical, electronic, etc. These main parts are:

- Machine frame
- APS (Air/Power Supply) box containing:
  - miniPC
  - Power supplies
  - Air/vacuum system
- Servo motors and drives
- Print carriage composed of:
  - Print head
  - Ink supply tank
- Controller box composed of:
  - Printer Controller card
  - Head interface card
  - I/O interface board
- Linear encoder

This chapter, instead of walking through each subsystem and component, is organized into categories of symptoms as this approach is most beneficial to the users. Explanations and the appropriate resolutions are provided. If the resolution suggested is beyond the user’s capability, please contact Exile Tech’s support for service help.
6.2 – General Troubleshooting Guidelines

- Always turn on the machine first before starting the program. The machine is turned on by pressing the “Start” button next to the emergency switch, which must be released by turning it clock-wise.

- When cycling power to the whole system, follow these steps:
  - Exit the program
  - Turn off the machine by pressing the emergency switch
  - Turn off the computer
  - Wait at least 10 seconds
  - Turn on the computer
  - Turn on the machine by releasing the emergency switch and pressing the “Start” button next to it
  - Start the program

- Make sure proper air pressure is applied and all pressure indicators are in the appropriate range.

- Make sure enough ink wax is deposited in the ink supply tank, but not too much to produce over-fillings.

- Make sure the vacuum hoses connected to the print head are not clogged or obstructed.

- Make sure the “purge” function after a long period of inactivity, or right after warm-up.

- Keep both Y and X axis motion rails smooth and lubricated.

- Make sure the magnetic strip for the linear encoder is clean and free of ink wax deposits. For cleaning simply use a rug dumped with water, as the ink wax is water-soluble.
6.3 – Symptoms and resolutions

6.3.1 – Image quality

Most problems related to image quality are due to the printhead’s nozzles being clogged, ink starvation, air ingestion, or mechanical imperfection (usually in the Y-axis ball screw). Although the symptoms are visible on the printed image, the problem source may be on the print head or, in some tricky cases, on the ink feed or motion system.

The print head section is of 2.56” wide and has 256 nozzles spaced at 100 dpi. When printing one section of 600 dpi image, the head needs to have 6 passes, with an incremental Y-axis distance of 1/600” between successive passes. Understanding this fundamental concept may help identify the possible cause more easily.

6.3.1.1 – Missing horizontal lines

This usually happens after the machine has not been operated for a long time. A typical jet test image is shown here.

This means some nozzles may have been clogged with dried/hardened ink. In this case, perform “purge” function (see section 3.6 Purging the print head). Sometimes a power purge may be needed by adjusting the purge pressure to a higher value such as 10 psi (instead of ~4 psi as described in section 2.6 Adjusting the ink feed and purge pressures.) Then the printed jet test image should look like as follows:
6.3.1.2 – The top portion of each head section is not printed well

Usually it’s due to ink starvation that the on-head reservoir has not been provided with enough ink (through ink feed from the ink supply tank), hence the top portion of nozzles cannot jet out to have dark printed lines. To confirm and resolve the issue, please refer to section 6.3.2 Ink feed and air system related symptoms/resolutions.

6.3.1.3 – The top portion of each head section loses printed lines gradually section by section

This is different from the issue of ink starvation described in section 6.3.1.2. Usually the printed image of the first head section (of 2.56” wide) is fine. The missing printed lines start showing up at the top portion in later sections and may deteriorate gradually section by section as the printing continues. If it’s determined not to be the “ink starvation” issue (please refer to section 6.3.2), then this is the so-called “air ingestion” phenomenon as described in section 2.8 Adjusting the low (meniscus) vacuum.

There are two possible resolutions: selecting a slower printing speed or lowering the low (meniscus) vacuum. Either one may prevent the air ingestion from happening. To adjust the low vacuum, please refer to section 2.8, or contact Exile Tech’s support. However, be aware that a meniscus vacuum adjusted too low may cause the weeping on the bottom nozzles (due to ink’s gravity).

After either resolution is performed, do a purge to push out the air trapped in the top nozzles before resuming the printing operation.

6.3.1.4 – Visible gap or overlapping at the junction between two consecutive head sections

The printed image may show gaps (horizontal white lines) between two consecutive head sections as follows,
or overlapping (darker lines) due to the last lines of the previous head section and the first lines of
the current one printed at almost the same space as:

This is in fact an issue of motion-related machine calibration. Please refer to the adjustment of
Y-spacing in section 4.5.7 Calibration. A few minor tunings would fix the issue.

6.3.1.5 – Visible vertical misalignment between two consecutive head sections

An example printed image is shown here.

Note the vertical lines in the 2\textsuperscript{nd} head section is disconnected (off to right) from the 1\textsuperscript{st} section,
instead of a seamless transition, and it’s due to the tilting of the printhead.
There are three degrees of freedom for the printhead’s position/orientation: Z-axis gap (described in section 2.9 Setting the print head distance), tilt left/right, and tilt down/up. The latter two are illustrated below:

The example printed image illustrates the case of the head being tilted to user’s right.

If the printed image exhibits such symptom, please contact Exile Tech’s support for service help. However, a brief description of procedure is listed here for reference in case the user would like to get their hands on it.
Remove the cover on the head assembly, and locate the screw on the bottom plate to the right of the head. The screw needs to touch the plate of the head and is used for adjustment (using a 3mm or 4mm screwdriver, or T-handle Allen wrench) as:

- To tilt the printhead to right, turn the screw clockwise.
- To tilt the printhead to left, turn the screw counterclockwise.

To determine if a print head is tilted forwards/backwards and an adjustment is required, only a visual inspection can be performed. For convenience of inspection, print any image and click the Pause button during printing so that the head will stop in front of the screen, and take a side view of the distances between the screen and the top and bottom of the head.

The two screws to the left of the printhead can be used for adjustment:
• To tilt the printhead forwards, turn the top screw clockwise.
• To tilt the printhead backwards, turn the bottom screw clockwise.
6.3.2 – Ink feed and air system related symptoms/resolutions

A simplified diagram of the printhead tank (on-head reservoir, omitting the ink-feed inlet and the nozzle plate outlet for clarity) is illustrated below. The air tube serves two functions:

- As an inlet during purge, the pressurized air comes in and pushes the ink (via the nozzle plate outlet) out of the nozzles, or
- As an outlet during normal operation, the vacuum system maintains a preset meniscus vacuum above the ink surface to prevent the bottom nozzles from weeping (due to ink’s gravity)

![Printhead Tank Diagram](image)

The thermistor shown in the middle is the Low On Ink Sensor (LOIS), used as a feedback element to implement the appropriate ink feed function. The rationale is based on the indirect sensing of the ink level via LOIS reading. The left-side numbers are the LOIS temperature readings at different ink levels: it’s low when the LOIS is submerged in the ink (i.e., ink level is high), and it’s high when the LOIS is above the ink surface (i.e., ink level is low).

The optimal LOIS threshold setting is the LOIS temperature when the ink level is about at LOIS’s position. Hence if the ink level falls, LOIS reading becomes higher than the setting and the ink feed function is activated. After the ink level rises (normally due to ink feed being performed) to LOIS’s position, LOIS reading becomes lower than the setting and the ink feed function stops.

The ink starvation issue described in section 6.3.1.2 The top portion of each head section is not printed well is the case where the LOIS threshold setting is too high, hence the ink feed function
is seldom activated (since the software considers the ink level is ok even though the actual ink level is too low).

On the other hand, if the LOIS threshold setting is too low, the ink feed function is continuously activated since the software considers the ink level is too low though the actual ink level is too high and continues rising. This may result in the “back wash” phenomenon, i.e., ink backflow through the low (meniscus) vacuum line.

In the diagram shown above, the optimal LOIS setting should be somewhere between 138° and 146°. A good starting guess is 142°. However, the LOIS threshold setting may vary machine by machine due to difference in target temperatures (head and ink tank) set in normal operation as well as the inherent accuracy limitation of thermistors. Hence it is tuned to each machine in factory before shipping to the customer.

The user may verify the LOIS threshold setting occasionally as follows:

- Click Tools > Graph to open Spyder Graph Utility window.
- Select Pumping Ink, LOIS Sensor and Purge Pump Signal to view.
- Perform Purge function (see section 3.6 Purging the print head).
- Watch the display in the Spyder Graph Utility window/

A typical display is shown here:

In this real example, the LOIS threshold setting is 142.5° and the LOIS reading is ~139° when the machine is not printing. After performing “purge” (with a duration set at 2.5 sec), the LOIS
reading starts rising, since the ink level drops. When it reaches at 142.5°, the ink feed function is activated for a duration of 2 seconds. After just one trial, the LOIS reading starts falling since the ink level rises. Eventually the LOIS reading will fall back to ~139° as before.

This example shows the case of a correct LOIS setting. In fact, when printing most half-tone images, only one or two ink feed trials are required per image for a proper LOIS threshold setting.

Many consecutive ink feed trials are seldom needed unless the LOIS threshold setting is too low. If after max trials, the LOIS reading is still higher than the setting, an error message such as “Head’s ink feed error…” will be displayed. You may go to Tools > Engineer settings > Ink system to reset the error, and also immediately inspect if there’s any ink backflow in the low (meniscus) vacuum tube.

One exceptional case allowing a low LOIS threshold setting (so that max trials of ink feed are performed, followed by resetting the error) is when a new printhead is installed and a fair amount of ink needs to be fed in the on-head reservoir.

6.3.3 – Motion-related symptoms

Most symptoms related to the motion system would start with whining or squeaking noise. When the problem deteriorates, a message stating “Motion error…” plus some error code indicating it’s about X- or Y- axis as well as “position error” or “overcurrent” is displayed. Usually it’s due to looseness in the coupler (Y-axis), or in the bearings driven by the pulley belt (X-axis). In some cases, reseating the Y-axis ballscrew may be required.

Please contact Exile Tech’s support for service help.

6.3.4 – Image file and template setting related symptoms

Usually the error messages are self-explanatory. For image files, the Control Panel software accepts only 1-bit TIFF files (uncompressed or compressed). One common error is that the image file’s size is larger than the template’s size or than the machine’s printable size.

6.3.5 – Other symptoms

For any symptoms not described here, please contact Exile Tech’s support for service help.

END